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ApSIC Xbench permite organizar y utilizar terminología bilingüe de 
referencia y, además, ofrece varias comprobaciones de control de calidad 
(QA) para elevar la calidad de las traducciones. 

Funciones de búsqueda 

ApSIC Xbench permite llevar a cabo búsquedas avanzadas en los 
siguientes formatos bilingües: 

� Archivos de texto delimitado por tabulaciones (*.txt) 

� Archivos XLIFF (*.xlf, *.xlif, *.xliff) 

� Memorias en formato TMX (*.tmx) 

� Glosarios en formato TBX/MARTIF (*.xml, *tbx, *.mtf) 

� Memorias de Trados exportadas (*.txt) 

� Glosarios de Trados MultiTerm 5 exportados (*.txt) 

� Glosarios de Trados MultiTerm en formato XML (*.xml) 

� Archivos de Trados TagEditor (*.ttx) 

� Archivos sucios de Word para Trados (*.doc, *.rtf) 

� Archivos de Trados Studio (*.sdlxliff, *.sdlproj) 

� Archivos en formato ITD de SDLX (*.itd). Nota: Para esta opción, se 
necesita tener SDLX instalado en el equipo.  

� Memorias de SDLX (*.mdb) 

� Árbol de directorio de STAR Transit 2.6/XV 

� Archivos PO (*.po) 

� Diccionarios de IBM TranslationManager exportados (*.sgm) 

� Carpetas de IBM TranslationManager instaladas y exportadas (*.fxp)  

� Memorias de IBM TranslationManager exportadas (*.exp) 

� Diccionarios de OpenTM2 exportados (*.sgm) 

� Carpetas de OpenTM2 instaladas y exportadas (*.fxp)  

� Memorias de OpenTM2 exportadas (*.exp) 

� Memorias de Wordfast (*.txt) 

� Glosarios de Wordfast (*.txt) 

� Archivos TXML de Wordfast Pro 

� Archivos de Déjà Vu X/Idiom (*.wsprj, *.dvprj) 

� Memorias de Déjà Vu X/Idiom (*.wsprj, *.dvprj) 

� Archivos RTF de Logoport (*.rtf) 

Descripción general 
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� Glosarios de software de Microsoft (*.csv) 

� Glosarios de Mac OS X (*.ad) 

� Glosarios de Remote Xbench Server 

La terminología de referencia se puede organizar según varios niveles de 
prioridad a fin de mostrar claramente a los traductores cuáles son las 
preferencias específicas de un proyecto de traducción.  

ApSIC Xbench se ejecuta en un segundo plano y se puede realizar una 
búsqueda del texto marcado utilizando una combinación de teclas válida 
en todo el sistema (por defecto, Ctrl+Alt+Ins), lo cual brinda la posibilidad 
de una búsqueda terminológica instantánea desde cualquier aplicación de 
Windows mediante una combinación de teclas en común. 

ApSIC Xbench incluye un motor de búsqueda muy potente. No solo se 
puede buscar por texto fuente o meta sino que también se pueden llevar a 
cabo búsquedas negativas o condicionales mediante la función 
PowerSearch (Ctrl+P) o efectuar búsquedas complejas utilizando la sintaxis 
de las expresiones regulares o los caracteres comodín de Microsoft Word.  

Nota: Una vez abierto, ApSIC Xbench permanece en un segundo plano 
hasta que se cierra de manera explícita con el comando Shutdown 

Xbench, disponible con un clic derecho en el icono de la barra de tareas 
de Windows o mediante el menú desplegable Project.  

Funciones de QA 

Al definir los archivos de traducción actuales como traducción en curso 
en un proyecto de ApSIC Xbench, se pueden ejecutar las siguientes 
comprobaciones de QA: 

� Buscar segmentos sin traducir 

� Buscar segmentos con el mismo texto fuente y distinto texto meta 

� Buscar segmentos con el mismo texto meta y distinto texto fuente 

� Buscar segmentos cuyo texto meta es idéntico al texto fuente (texto 
potencialmente sin traducir) 

� Buscar inconsistencias de etiquetas 

� Buscar inconsistencias numéricas 

� Buscar dobles espacios 

� Buscar palabras repetidas 

� Buscar inconsistencias terminológicas respecto de una lista de 
términos clave 

� Ejecutar listas de comprobación definidas por el usuario 

� Corregir la ortografía de las traducciones (lo cual requiere la descarga 
del complemento para el diccionario según el idioma) 



 

 Capítulo 1 5 
 
 

Las listas de comprobación son búsquedas definidas por el usuario que se 
pueden ejecutar en lote respecto de la traducción en curso. Por ejemplo, 
con una lista de comprobación se pueden encontrar palabras prohibidas o 
problemas de traducción típicos. 
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Instalación y desinstalación de 
ApSIC Xbench 

Para instalar ApSIC Xbench 

Para instalar ApSIC Xbench, siga estos pasos: 

Ejecute el archivo de instalación (por ejemplo, Setup.Xbench.2.9.exe). 
Aparece la ventana de bienvenida del instalador. 

 

Haga clic en Next. Aparece la ventana de la licencia. Lea de manera 
detenida la información sobre la licencia a fin de asegurarse de aceptar 
las condiciones. 

Si acepta las condiciones de la licencia, haga clic en I Agree.  Si no las 
acepta, haga clic en Cancel. 

C A P Í T U L O  1  
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De ser necesario, cambie la carpeta de destino y haga clic en Install para 
continuar. 

Los archivos se copian al destino seleccionado y aparece la siguiente 
ventana: 

 

Haga clic en Finish para cerrar la ventana y comenzar a utilizar 
ApSIC Xbench. 
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Se instala un vínculo al archivo ejecutable de ApSIC Xbench en la ruta 
Inicio->Programas->ApSIC Tools->Xbench, junto con la 
documentación. 

Para desinstalar ApSIC 
Xbench 

Para desinstalar ApSIC Xbench, siga estos pasos: 

1 Elija Inicio->Configuración->Panel de control en la barra de tareas 
de Windows. Vaya al Panel de control de Windows y abra el icono 
Agregar o quitar programas. 

2 Busque ApSIC Xbench en la lista y haga clic en el botón Cambiar o 

quitar. 

3 Cuando obtenga el mensaje de confirmación, haga clic en Sí. 
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Inicio y cierre de ApSIC 
Xbench 

ApSIC Xbench es una aplicación que, una vez iniciada, se debe cerrar de 
manera explícita si ya no es necesaria.  Por lo general, se carga el 
proyecto de referencia para buscar terminología mientras se traduce y 
queda en un segundo plano hasta que se termina el trabajo de traducción.  
Cerrar la ventana de ApSIC Xbench no implica quitar el programa de la 
memoria porque sigue esperando la próxima búsqueda mediante la 
secuencia de teclas Ctrl+Alt+Ins. 

Cómo iniciar ApSIC 
Xbench 

Para iniciar ApSIC Xbench, siga alguno de estos procedimientos: 

� Elija Inicio->Programas->ApSIC Tools->Xbench en la barra de 
tareas de Windows. 

� Haga doble clic en el icono de un proyecto de ApSIC Xbench 
previamente definido (con extensión *.xbp). 

Cómo cerrar ApSIC Xbench 

Para cerrar ApSIC Xbench, se tienen las siguientes opciones: 

� Haga clic derecho en el icono de ApSIC Xbench (una gema rosa) 
ubicado en la bandeja del sistema y haga clic en Shutdown Xbench. 

� En el menú Project, haga clic en Shutdown Xbench. 

 

 

C A P Í T U L O  2  
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En esta sección, se detallan las funciones de búsqueda de ApSIC Xbench.  
A fin de entender el funcionamiento de ApSIC Xbench, resultan útiles los 
siguientes conceptos: 

Proyecto: En ApSIC Xbench, un proyecto es una definición de archivos 
junto con sus prioridades y relaciones. Lo primero que se debe hacer en 
ApSIC Xbench es definir un proyecto que incluya la terminología que se 
desea buscar e indicar cómo se debe buscar. 

Traducción en curso: ApSIC Xbench permite marcar un archivo o un 
conjunto de archivos como “traducción en curso” y, luego, identificar 
visualmente las cadenas en los resultados de una búsqueda. Además, las 
funciones de QA se pueden llevar a cabo únicamente en los archivos 
definidos como traducción en curso. 

Lista de comprobación: En ApSIC Xbench, una lista de comprobación es 
una serie de búsquedas que se pueden ejecutar en lote. 

PowerSearch: Se trata de un modo especial de búsqueda, por el cual se 
pueden definir condiciones Y/O y negaciones a la cadena de búsqueda a 
fin de llevar a cabo búsquedas complejas.  Se trata de una función muy 
útil para actividades relacionadas con QA. 

Expresión regular: Una expresión regular es una cadena de búsqueda que 
contiene caracteres especiales con significados específicos que permiten 
determinar una manera concisa y flexible de identificar patrones de 
caracteres y palabras. La sintaxis de las expresiones regulares es 
consistente con los estándares de la industria. Es uno de los modos de 
búsqueda y QA de ApSIC Xbench. 

Comodín de Microsoft Word: ApSIC Xbench también permite efectuar 
búsquedas utilizando los comodines de Microsoft Word, los cuales siguen 
una sintaxis similar a la de las expresiones regulares aunque, 
normalmente, se trata de una versión alternativa simplificada. 

  

 

Búsqueda de terminología 
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Definición de proyectos de 
búsqueda 

El primer paso para utilizar las funciones de búsqueda avanzada de 
ApSIC Xbench es definir el material de referencia del proyecto. Para ello, 
se deben agregar los archivos y directorios pertinentes al proyecto desde 
Project->Properties o presionando F2. Aparece el cuadro de diálogo 
Project Properties que se muestra a continuación. 

 

Haga clic en el botón Add para agregar archivos al proyecto. 

Seleccione el tipo de archivo que se agrega al proyecto de 
ApSIC Xbench: 

 

C A P Í T U L O  3  
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ApSIC Xbench admite los siguientes formatos de archivo: 

� Archivo de texto delimitado por tabulaciones (*.txt). Un archivo donde 
cada línea consta de una cantidad de campos delimitados por el 
carácter de tabulación. El primer y el segundo campo de una entrada 
suponen ser el texto fuente y el texto meta respectivamente. Los 
campos adicionales suponen ser descriptivos y pueden aparecer en 
una cantidad indefinida. 

� Archivo XLIFF (*.xlf, *.xlif, *.xliff). Un archivo que cumple con la 
especificación XLIFF. 

� Memoria en formato TMX (*.tmx). Un archivo que cumple con la 
especificación TMX. La mayoría de las herramientas de traducción 
pueden generar memorias en formato TMX según distintos niveles de 
conformidad. 

� Glosario en formato TBX/MARTIF (*.xml, *.tbx, *.mtf). Un archivo que 
cumple con la especificación TBX o MARTIF. 

� Memoria de Trados exportada (*.txt). Una memoria de Trados en 
formato *.txt según se exportó desde Trados. 

� Glosario de Trados MultiTerm 5 exportado (*.txt). Un glosario de 
MultiTerm exportado en un archivo *.txt donde cada entrada se 
encuentra delimitada con una línea que tiene dos asteriscos (**). 

� Glosario de Trados MultiTerm en formato XML (*.xml). Un glosario de 
MultiTerm exportado en formato XML. 

� Archivo de Trados TagEditor (*.ttx). Un archivo *.ttx de Trados. 

� Archivo de Word para Trados (*.doc, *.rtf). Un archivo *.doc o *.rtf 
para Trados con segmentos bilingües. 

� Archivo de Trados Studio (*.sdlxliff, *.sdlproj). Un archivo *.sdlxliff o 
*.sdlproj de Trados Studio. Cuando se especifica un archivo de 
proyecto de Trados Studio (*.project), ApSIC Xbench abre los 
archivos *.sdlxliff indicados por el archivo de proyecto para el primer 
par de idiomas que se encuentra en el archivo de proyecto. 

� Archivo de SDLX (*.itd). Un archivo *.itd de SDLX. Nota: Para esta 
opción, se necesita tener SDLX instalado en el equipo.  

� Memoria de SDLX (*.mdb). Un archivo individual *.mdb de SDLX que 
contiene una memoria de traducción. 

� Árbol de directorio de STAR Transit 2.6/XV. Un directorio que contiene 
los pares de archivos de Transit. Cabe destacar que ApSIC Xbench no 
admite pares de archivos de STAR Transit NXT. 

� Archivo PO. Un archivo bilingüe *.po, por lo común generado con 
gettext. 

� Diccionario de IBM TM/OpenTM2 (*.sgm). Un diccionario de IBM 
TranslationManager o de OpenTM2 en formato SGML. Este archivo 
tiene la extensión *.sgm. 

� Carpeta de IBM TM/OpenTM2. Una carpeta de IBM 
TranslationManager o de OpenTM2 instalada en el sistema. Este 
formato se puede definir como traducción en curso a fin de distinguir 
de manera clara la traducción nueva respecto de la anterior y también 
de mostrar los segmentos sin traducir y así poder tomar mejores 
decisiones en cuanto a la nueva terminología. 
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� Carpeta de IBM TM/OpenTM2 exportada (*.fxp). Una carpeta de IBM 
TranslationManager o de OpenTM2 exportada en formato *.fxp. 

� Memoria de IBM TM/OpenTM2 exportada (*.exp). Una memoria de IBM 
TranslationManager o de OpenTM2 exportada en formato *.exp. 

� Memoria de Wordfast (*.txt). Una memoria de Wordfast, con la 
extensión *.txt. 

� Glosario de Wordfast (*txt). Un glosario de Wordfast, con la extensión 
*.txt. 

� Archivo TXML de Wordfast Pro (*.txml). Un archivo bilingüe de 
Wordfast Pro, con la extensión *.txml. 

� Archivo de Déjà Vu X/Idiom (*.wsprj, *.dvprj). Una base de datos de 
Déjà Vu o de Idiom de los archivos de traducción de un proyecto, con 
extensiones *.dvprj o *.wsprj. 

� Memoria de Déjà Vu X/Idiom (*.wstm, *.dvmdb). Una memoria de 
traducción de Déjà Vu o de Idiom, con extensiones *.dvmdb o 
*.wstm. 

� RTF de Logoport (*.rtf). Un archivo individual *.rtf de Logoport o un 
directorio con archivos *.rtf de Logoport. 

� Glosario de Microsoft (*.csv). Un glosario de software de Microsoft, 
puesto a disposición del público por parte de Microsoft vía MSDN y 
que contiene todas las cadenas de una aplicación de software de 
Microsoft. 

� Glosario de Mac OS X (*.ad). Un archivo en formato XML para 
software de Apple, el cual se puede descargar de manera gratuita en 
Internet. 

� Remote Xbench Server. Una referencia a un glosario en Remote 
ApSIC Xbench Server. 

Después de seleccionar el tipo de archivo, aparece la pestaña File List, 
donde se pueden agregar múltiples entradas del tipo seleccionado.  Según 
el tipo de archivo elegido, haga clic en el botón Add File... o Add 

Folder... para agregar entradas a la lista. 

A partir de este punto, la secuencia de pantallas puede ser diferente, 
dependiendo del tipo de archivo seleccionado. Siga las instrucciones 
correspondientes al tipo específico de archivo para obtener los pasos 
exactos. 

 

Si se agrega... Siga estos pasos: 

Un archivo de texto delimitado 
por tabulaciones, un archivo 
XLIFF, una memoria TMX, 
una memoria de Trados 
exportada, un archivo de 
Trados TagEditor, un archivo 
de Word para Trados, un 
archivo de Trados Studio, un 

1 Aparece la pestaña File List. Haga 
clic en Add File... o Add Folder... 
para agregar archivos o carpetas de 
archivos del tipo seleccionado. En 
la lista, las carpetas aparecen en 
negrita. 

2 Haga clic en Next en la pestaña 
File List para ir a la pestaña 
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archivo de SDLX, una 
memoria de SDLX, un archivo 
PO, un diccionario de IBM 
TM/OpenTM2, una carpeta de 
IBM TM/OpenTM2 
exportada, una memoria de 
IBM TM/OpenTM2 
exportada, una memoria de 
Wordfast, un glosario de 
Wordfast, un archivo TXML 
de Wordfast Pro, un glosario 
de Microsoft, un glosario de 
Mac OS X, un archivo de Déjà 
Vu X/Idiom, una memoria de 
Déjà Vu/Idiom, un archivo 
RTF de Logoport 

Properties. 

3 Asigne las propiedades pertinentes 
y haga clic en OK para terminar. 
Nota: Si se agregaron carpetas en el 
paso 1, haga clic en Next para 
pasar a un panel adicional donde se 
puede indicar si se desea incluir 
archivos del mismo tipo en carpetas 
secundarias con la casilla Recurse 

Directories. 

Árbol de directorio de STAR 
Transit 

1 Después de que aparece la pestaña 
File List, se abre de manera 
automática el cuadro de diálogo 
Select Directory. Navegue hasta el 
directorio que contiene los archivos 
que se desean cargar en el proyecto 
de ApSIC Xbench. 

2 Haga clic en Next en la pestaña 
File List para ir a la pestaña 
Properties. 

3 Asigne las propiedades pertinentes 
al árbol de directorio y haga clic en 
Next para pasar a la pestaña 
Directory Settings. 

4 En la pestaña Directory Settings, 
se puede tildar la casilla Recurse 

Directories a fin de que 
ApSIC Xbench busque también 
archivos en los subdirectorios. 

Glosario de Trados MultiTerm 
5 exportado, de Trados 
MultiTerm en formato XML, 
o en formato TBX/MARTIF 

1 Aparece la pestaña File List y se 
abre de manera automática el 
cuadro de diálogo Add Glossary. 
Seleccione todos los archivos del 
tipo actual en esta ventana.  Si se 
deben seleccionar más archivos 
desde otro directorio, cuando 
vuelva a la pestaña File List, haga 
clic en el botón Add File a fin de 
volver a abrir la ventana Add 

Glossary. 

2 Haga clic en Next en la pestaña 
File List para ir a la pestaña 
Properties. 

3 Asigne las propiedades pertinentes 
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al archivo y haga clic en Next para 
pasar a la pestaña correspondiente 
al formato de archivo. 

4 Seleccione el idioma fuente y el 
idioma meta de la lista de idiomas 
que aparece y haga clic en OK para 
terminar. 

Carpeta de IBM 
TM/OpenTM2 

1 Después de que aparece la pestaña 
File List, se abre de manera 
automática el cuadro de diálogo 
Select IBM TM/OpenTM2 

Folder. De ser necesario, cambie a 
la unidad que contiene la carpeta de 
IBM TM o de OpenTM2 y, luego, 
seleccione las carpetas en la lista de 
carpetas que aparece. 

2 Haga clic en Next en la pestaña 
File List para ir a la pestaña 
Properties. 

3 Asigne las propiedades pertinentes 
y haga clic en OK para terminar. 

Remote Xbench Server 1 Asigne las propiedades pertinentes 
y haga clic en Next para pasar a la 
pestaña Remote Xbench Server. 

2 Asigne un nombre para la conexión 
y especifique la URL del Xbench 
Server. 

Al volver a la ventana Project Properties, se pueden agregar otros 
archivos o directorios siguiendo los pasos descritos anteriormente. 

Al terminar, haga clic en OK en la ventana Project Properties para 
volver a la ventana principal de ApSIC Xbench. ApSIC Xbench carga los 
glosarios en el entorno de trabajo. 

En este punto, desde el menú Project, haga clic en Save as para guardar 
la definición de glosario recién creada en el directorio junto con otros 
proyectos de ApSIC Xbench. Se recomienda guardar los archivos de 
proyecto con un nombre significativo para uso posterior.  

Nota: La próxima vez que se inicia, ApSIC Xbench carga de manera 
automática el último proyecto, a menos que se deshabilite esta función 
desde Tools->Settings->Miscellaneous Settings. 
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Búsqueda de términos 

ApSIC Xbench tiene un motor de búsqueda muy potente. Por ejemplo, se 
puede buscar según un término fuente, un término meta o un término 
tanto fuente como meta. ApSIC Xbench también permite buscar 
utilizando expresiones regulares o comodines de Microsoft Word, y 
combinándolos mediante el modo PowerSearch. 

 

Probablemente, la mayoría de las búsquedas se lleven a cabo según un 
término fuente. Sin embargo, no habrá necesidad de buscar un término 
mientras se trabaje en la interfaz de ApSIC Xbench, sino cuando se esté 
traduciendo en Word o en alguna aplicación CAT como Trados 
Translator’s Workbench, SDLX, IBM TranslationManager, Déjà Vu, o 
cuando se esté redactando en un programa de correo electrónico como 
Microsoft Outlook o Firebird. 

Esa es la razón por la que se puede acceder a ApSIC Xbench desde 
cualquier aplicación en todo el sistema, mediante una combinación de 
teclas única (Ctrl+Alt+Ins). 

Los siguientes 5 pasos describen cómo interactuar con ApSIC Xbench. El 
punto de inicio de esta situación imaginaria es un documento abierto en 
Microsoft Word en un primer plano y un proyecto de ApSIC Xbench 
cargado en un segundo plano. 

1 En Microsoft Word, resalte (de manera total o parcial) el término que 
desea buscar.  

C A P Í T U L O  4  
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2 En Microsoft Word, presione Ctrl+Alt+Ins para activar 
ApSIC Xbench. Esta acción inicia una búsqueda automática del 
término marcado en los archivos cargados en ApSIC Xbench. Dicha 
secuencia de teclas es la más importante mientras se utiliza 
ApSIC Xbench.  

3 ApSIC Xbench presenta los resultados de la consulta como se 
muestra en la figura anterior. 

Se pueden tener hasta tres áreas de prioridad: una en verde (prioridad 
elevada), una en granate (prioridad intermedia) y una en azul 
(prioridad reducida). La columna etiquetada como # ofrece un conteo 
de todas las repeticiones en el archivo que se agruparon para la 
entrada que se muestra en la ventana. 

La viñeta verde  junto al término meta indica que la entrada es una 
coincidencia exacta (distingue mayúsculas y minúsculas) con la 
cadena de búsqueda. Si aparece una viñeta amarilla  junto al término 
meta, significa que la entrada es una coincidencia total salvo por las 
mayúsculas y minúsculas. Por ejemplo, si en el ejemplo anterior se 
buscara “Clipboard” en lugar de “clipboard”, las viñetas serían verdes 
en lugar de amarillas, dado que las mayúsculas y minúsculas de la 
cadena de consulta coincidirían de manera exacta con las de la cadena 
que se encuentra en el archivo (“Clipboard”). 

Cuando se traduce documentación, es muy útil esta indicación ya que 
se puede copiar y pegar el término meta, lo cual resulta más 
productivo y preciso. Los siguientes pasos describen cómo 
aprovechar esta ventaja. 

4 Si desea copiar el término meta de la entrada actualmente 
seleccionada en el portapapeles, presione Intro para cerrar la ventana 
de ApSIC Xbench. ApSIC Xbench se esconde y se vuelve a la otra 
aplicación (en este ejemplo, Microsoft Word). 

Nota: Si no se desea copiar nada en el portapapeles, presione Esc o 
Alt+F4 para esconder ApSIC Xbench y volver a Microsoft Word. 

5 Si se ha optado por cerrar la ventana de ApSIC Xbench con la tecla 
Intro, lo cual guarda el término meta en el portapapeles, se puede 
presionar Mayús+Ins para copiar el término meta en el documento. 

Notará que, en especial para las opciones de software, resulta más rápido 
buscar y pegar en lugar de escribir las opciones de software meta 
manualmente. Así, se logra ser más productivo y, al mismo tiempo, las 
traducciones son más consistentes. 

Sugerencia: Familiarícese con el procedimiento descrito hasta sentir que 
se vuelve intuitivo. Pruebe con palabras que sean coincidencias exactas 
para familiarizarse con la etapa de pegado. 
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Expresiones regulares y 
comodines de Microsoft Word 

ApSIC Xbench permite realizar búsquedas avanzadas utilizando 
expresiones regulares o comodines de Microsoft Word.  Para activar estos 
modos de búsqueda: 

1. Elija View->Search Options para mostrar el panel Search Options. 

2. Expanda el menú desplegable Search Mode y elija Regular 

Expressions o MS Word Wildcards. 

3. Notará que aparece un icono junto a los campos Source Term y 
Target Term para indicar el modo de búsqueda seleccionado. 

Sintaxis de las expresiones regulares 

Carácter o 
expresión 

Significado Ejemplos 

. Cualquier carácter Jo.n coincide con John y Joan, pero no con 
Johan. 

* 0 o más instancias del carácter 
anterior 

Joh*n coincide con Jon, John y Johhn, pero 
no con Johan. 

Nota: En las expresiones regulares, el asterisco 
no se comporta igual que en los comodines de 
Microsoft Word. Para que signifique cualquier 
cantidad de caracteres, se tiene que utilizar la 
secuencia punto-asterisco (.*). Por ejemplo, 
Joh.*n coincide con John, Johhn y Johan 
(pero no con Jon). 

? 0 o 1 instancia del carácter 
anterior 

Joh?n coincide con Jon y John, pero no con 
Johan. 

+ 1 o más repeticiones del carácter 
anterior 

Joh+n coincide con John y Johhn, pero no con 
Jon o Johan. 

{m} Exactamente m repeticiones del 
carácter anterior 

Joh{2}n coincide con Johhn, pero no con Jon, 
John o Johhhn. 

{m,} m o más repeticiones del 
carácter anterior 

Joh{2,}n coincide con Johhn y Johhhn, pero 
no con Jon o John. 
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{,n} De 1 a n repeticiones del 
carácter anterior 

Joh{,2}n coincide con John y Johhn, pero no 
con Jon o Johhhn. 

{m,n} De m a n repeticiones del 
carácter anterior 

Joh{1.2}n coincide con John y Johhn, pero no 
con Jon o Johhhn. 

< Comienzo de palabra <Phon coincide con Phone pero no con 
iPhone. 

> Final de palabra hones> coincide con Phones pero no con 
Phone. 

Nota: Para que coincida con una palabra entera, 
se puede especificar <Phone> para Phone, pero 
no para Phones o iPhone; o se puede 
especificar <Phones*> para Phone y Phones 
pero no para iPhone o iPhones. 

^ Comienzo de línea (tiene que 
estar al principio de la 
expresión) 

^Phone coincide con todas las unidades que 
comiencen con Phone. 

$ Final de línea (tiene que estar al 
final de la expresión) 

received$ coincide con todas las unidades que 
terminen con received. 

\ Carácter de escape: el carácter 
que lo sigue se analiza como un 
carácter simple. 

phone\. coincide con todas las unidades que 
tengan un punto después de phone (en este 
caso, el punto no significa “cualquier carácter” 
porque está escapado). 

% Hace que el carácter o la 
expresión anterior no distinga 
mayúsculas y minúsculas.  
Cuando el modo de búsqueda de 
ApSIC Xbench distinga 
mayúsculas y minúsculas, este 
modificador se puede utilizar 
para hacer que parte de una 
cadena de búsqueda no las 
distinga. 

En el modo de mayúsculas y minúsculas de 
ApSIC Xbench, a% coincide con a y A. De 
manera similar, P(hone)% coincide con Phone 
y PHONE, pero no coincide con phone porque 
en este caso la letra p no se encuentra incluida 
en la expresión afectada por el modificador. 

\xnn El carácter especificado por nn, 
donde nn es un número 
hexadecimal. 

\x48\x6f\x77\x64\x79\x3f coincide con 
Howdy? 

| Operador O ^H|I coincide con todas las oraciones que 
comiencen con una H o con una I. 

( ) Operador de paréntesis para 
especificar prioridad 

(^H)|I coincide con todas las oraciones que 
comiencen con una H o que contengan una I. 
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[set-expression] Un carácter que pertenece al 
conjunto definido por una 
expresión de conjuntos. Un 
conjunto se define mediante 
caracteres individuales (por 
ejemplo, [aeiou]) o por rangos 
de caracteres especificados por 
el carácter inicial y final (por 
ejemplo, [a-z]). 

File[0-9] coincide con File0, File1, File2... 
File9, pero no con FileX. 

File[ABC] coincide con FileA, FileB y FileC, 
pero no con FileD. 

[:special-set:] Un carácter que pertenece a un 
conjunto especial predefinido. 
En ApSIC Xbench, están 
predefinidos los siguientes 
conjuntos especiales: [:space:], 
[:control:], [:punctuation:], 
[:punct:], [:separator:], [:sep:], 
[:symbol:], [:alpha:], [:num:], 
[:xdigit:], [:alphanum:], 
[:letter:], [:digit:], [:letterdigit:], 
[:number:]. Un conjunto especial 
se debe utilizar dentro de 
expresiones de conjuntos (por 
ejemplo, [:digit:]). Los 
caracteres con los que coincide 
cada conjunto especial se 
encuentran listados en 
Conjuntos especiales (en la 
página 29). 

File[:digit:] coincide con File0, File1 o File2, 
pero no con FileA o FileB. 

File[:alpha:][:digit:] coincide con FileA0, 
FileB1 o FileC2, pero no con File1A o File2B. 

[^set-
expression] 

Cualquier carácter que no 
pertenezca a la expresión de 
conjuntos. 

File[^ABC] coincide con FileD o FileE, pero 
no con FileA, FileB y FileC. 

(expression)=n Asigna a una variable n el valor 
resuelto de la expresión en el 
segmento actualmente 
analizado.  El valor resuelto se 
puede recuperar con la expresión 
@n. 

(File[0-9])=1 define la variable 1 como el valor 
resuelto de File[0-9]. 

@n Representa el valor resuelto de 
la variable n. 

@1 en el ejemplo anterior se resuelve en la 
cadena File1 si la cadena en la que se busca 
contiene File1, File2 si contiene File2 y así 
sucesivamente. 
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Sintaxis de los comodines de Microsoft Word 

Carácter o 
expresión 

Significado Ejemplos 

. Cualquier carácter Jo.n coincide con John y Joan, pero no con 
Johan. 

* 0 o más caracteres Joh*n coincide con John, Johan y Johhn, 
pero no con Jon. 

? 0 o 1 caracteres Jo?n coincide con Jon, John y Joan, pero no 
con Johan. 

@ 1 o más repeticiones del carácter 
anterior 

Joh@n coincide con John y Johhn, pero no 
con Jon o Johan. 

{m} Exactamente m repeticiones del 
carácter anterior 

Joh{2}n coincide con Johhn, pero no con Jon, 
John o Johhhn. 

{m,} m o más repeticiones del carácter 
anterior 

Joh{2,}n coincide con Johhn y Johhhn, pero 
no con Jon o John. 

{,n} De 1 a n repeticiones del carácter 
anterior 

Joh{,2}n coincide con John y Johhn, pero no 
con Jon o Johhhn. 

{m,n} De m a n repeticiones del 
carácter anterior 

Joh{1.2}n coincide con John y Johhn, pero no 
con Jon o Johhhn. 

< Comienzo de palabra <Phon coincide con Phone pero no con 
iPhone. 

> Final de palabra hones> coincide con Phones pero no con 
Phone. 

Nota: Para que coincida con una palabra entera, 
se puede especificar <Phone> para Phone, pero 
no para Phones o iPhone; o se puede 
especificar <Phones*> para Phone y Phones 
pero no para iPhone o iPhones. 

^ Comienzo de línea (tiene que 
estar al principio de la expresión) 

^Phone coincide con todas las unidades que 
comiencen con Phone. 

$ Final de línea (tiene que estar al 
final de la expresión) 

received$ coincide con todas las unidades que 
terminen con received. 

\ Carácter de escape: el carácter 
que lo sigue se analiza como un 
carácter simple. 

phone\. coincide con todas las unidades que 
tengan un punto después de phone (en este 
caso, el punto no significa “cualquier carácter” 
porque está escapado). 
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\xnn El carácter especificado por nn, 
donde nn es un número 
hexadecimal. 

\x48\x6f\x77\x64\x79\x3f coincide con 
Howdy? 

| Operador O ^H|I coincide con todas las oraciones que 
comiencen con una H o con una I. 

( ) Operador de paréntesis para 
especificar prioridad 

(^H)|I coincide con todas las oraciones que 
comiencen con una H o que contengan una I. 

[set-expression] Un carácter que pertenece al 
conjunto definido por una 
expresión de conjuntos. Un 
conjunto se define mediante 
caracteres individuales (por 
ejemplo, [aeiou]) o por rangos 
de caracteres especificados por el 
carácter inicial y final (por 
ejemplo, [a-z]). 

File[0-9] coincide con File0, File1, File2... 
File9, pero no con FileX. 

File[ABC] coincide con FileA, FileB y FileC, 
pero no con FileD. 

[:special-set:] Un carácter que pertenece a un 
conjunto especial predefinido. En 
ApSIC Xbench, están 
predefinidos los siguientes 
conjuntos especiales: [:space:], 
[:control:], [:punctuation:], 
[:punct:], [:separator:], [:sep:], 
[:symbol:], [:alpha:], [:num:], 
[:xdigit:], [:alphanum:], [:letter:], 
[:digit:], [:letterdigit:], 
[:number:]. Un conjunto especial 
se debe utilizar dentro de 
expresiones de conjuntos (por 
ejemplo, [:digit:]). Los caracteres 
con los que coincide cada 
conjunto especial se encuentran 
listados en Conjuntos especiales 
(en la página 29). 

File[:digit:] coincide con File0, File1 o File2, 
pero no con FileA o FileB. 

File[:alpha:][:digit:] coincide con FileA0, 
FileB1 o FileC2, pero no con File1A o File2B. 

[!set-
expression] 

Cualquier carácter que no 
pertenezca a la expresión de 
conjuntos. 

File[!ABC] coincide con FileD o FileE, pero 
no con FileA, FileB y FileC. 

(expression)=n Asigna a una variable n el valor 
resuelto de la expresión en el 
segmento actualmente analizado.  
El valor resuelto se puede 
recuperar con la expresión \n. 

(File[0-9])=1 define la variable 1 como el valor 
resuelto de File[0-9]. 
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\n Representa el valor resuelto de la 
variable n. 

\1 en el ejemplo anterior se resuelve en la 
cadena File1 si la cadena en la que se busca 
contiene File1, File2 si contiene File2 y así 
sucesivamente. 
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Conjuntos especiales 

La tabla a continuación muestra los caracteres con los que coinciden los 
conjuntos especiales que se pueden utilizar para las expresiones regulares 
y los caracteres comodines de Microsoft Word: 

Conjunto especial Caracteres con los que coincide el conjunto 
especial 

[:alpha:] Cualquiera de los caracteres considerados 
alfabéticos por el sistema operativo según la 
actual página de códigos ANSI. 

[:alphanum:] Cualquiera de los caracteres considerados 
alfanuméricos por el sistema operativo según la 
actual página de códigos ANSI. 

[:control:] Caracteres en el rango hexadecimal 0x00-0x19. 

[:digit:] Cualquier dígito de ‘0’ a ‘9’. 

[:letter:] Sinónimo de [:alpha:]. 

[:letterdigit:] Sinónimo de [:alphanumeric:]. 

[:num:], [:number:] Cualquier dígito de ‘0’ a ‘9’ y los siguientes 
números superíndices y fraccionarios: '¹', '²', '³', 
'¼', '½', '¾' 

[:punct:], 
[:punctuation:] 

Cualquiera de los siguientes caracteres: ! " # % & 
' ( ) * , - . / : ; ? @ [ \ ] _ { } ¡ « - · » ¿ 

[:sep:], [:separator:] Espacio (Hex 0x20) y espacio duro (Hex 0xA0) 

[:symbol:] Cualquiera de los siguientes caracteres: $ + <=> 
^ ` | ~ ¢ £ ¤ ¥ ¦ § ¨ © ¬ ® ¯ ° ± ´ ¶ ¸ × ÷ 

[:space:] Espacio (Hex 0x20), tabulaciones y retornos de 
carro en el rango Hex 0x09-0x0C, más Hex 0x85 
y Hex 0xA0. 

[:xdigit:] Cualquier dígito hexadecimal de ‘0’ a ‘9’ y de ‘a’ 
a ‘f’ (o de ‘A’ a ‘F’). 
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Funciones avanzadas 

ApSIC Xbench tiene algunas funciones avanzadas que se logran apreciar 
ante requerimientos especiales. Se describen en las secciones a 
continuación. 

Función PowerSearch 

Se puede utilizar la combinación de teclas Ctrl+P (PowerSearch) para 
buscar según criterios más complejos.  Con la función PowerSearch, se 
pueden buscar entradas:  

� que contienen dos o más cadenas, pero no necesariamente juntas; 

� que no contienen una cadena determinada; 

� que contienen una cadena u otra cadena; 

� cualquier combinación de las condiciones anteriores. 

Ejemplos: 

Esta expresión... ... hace lo siguiente 

cadena1 cadena2 Encuentra todas las entradas que contengan 
“cadena1” y “cadena2” 

cadena1 or cadena2 Encuentra todas las entradas que contengan 
“cadena1” o “cadena2” 

cadena1 -cadena2 Encuentra todas las entradas que contengan 
“cadena1” pero que no contengan “cadena2” 

cadena1 -“cadena2 con 
espacios en blanco 
incrustados” 

Encuentra todas las entradas que contengan 
“cadena1” pero que no contengan “cadena2 
con espacios en blanco incrustados” 

Se pueden utilizar paréntesis para indicar precedencia en expresiones más 
complejas que incluyan varias cadenas con relaciones booleanas Y/O. 

En el modo PowerSearch, se deben utilizar comillas dobles como 
delimitadores si la expresión contiene espacios en blanco incrustados o 
paréntesis. Si la cadena de búsqueda contiene una comilla doble 
incrustada, se debe escapar utilizando una secuencia de dos comillas 
dobles. 

Nota: Si una de las palabras por buscar en el modo PowerSearch es la 
palabra “or”, se debe encerrar la palabra “or” en comillas dobles a fin de 
evitar que sea analizada como el operador O. 
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Se puede utilizar PowerSearch en cualquiera de los siguientes modos: 
Simple, Regular Expressions o MS Word Wildcards. 

Zoom 

ApSIC Xbench ofrece 3 tipos de zoom: 

� Zoom a nivel 

� Zoom a glosario 

� Zoom a archivo 

Como se puede notar, ApSIC Xbench muestra una instantánea de los 
términos más pertinentes para cada nivel de prioridad en una vista 
unificada. Esto permite analizar el origen de potenciales inconsistencias 
o, incluso, distintos significados, además de tomar decisiones mejor 
fundamentadas respecto de cuál término elegir. 

Sin embargo, es posible que se quiera ver más instancias (o todas las 
instancias) de un nivel específico para llevar a cabo un análisis más 
riguroso de un término específico. 

Para ello, haga doble clic en el cuerpo de la ventana del nivel en el que se 
desea hacer zoom a fin de obtener una lista completa de las entradas para 
el término buscado. El fondo se vuelve verde, de forma tal que se 
reconoce como modo zoom. 

Para salir del modo zoom, haga doble clic nuevamente en el cuerpo de la 
ventana. 

Búsqueda inversa 

ApSIC Xbench también define una tecla válida en todo el sistema a fin de 
buscar en la columna meta en lugar de en la columna fuente. La 
combinación de teclas predeterminada para esta función es 
Ctrl+Alt+Retroceso. 

Esto equivale a dejar el campo Source Term en blanco y el campo 
Target Term relleno. 

Por ejemplo, resulta conveniente cuando se desea utilizar un término 
nuevo en el idioma de uno y se quiere tener por seguro que dicho término 
no está siendo utilizado para otro término, lo cual podría crear potenciales 
conflictos en el futuro especto de la terminología del proyecto. 
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Búsqueda únicamente en la 
traducción en curso 

En el panel Search Options, se puede tildar la casilla Only Ongoing 

Translation a fin de limitar la búsqueda a los archivos definidos como 
traducción en curso únicamente.  Esto resulta útil cuando se agrega una 
traducción actual al proyecto de ApSIC Xbench y se desea buscar y 
reemplazar de manera global solamente en la traducción en curso. 

Búsqueda únicamente en los 
segmentos nuevos 

En el panel Search Options, se puede tildar la casilla Only New 

Segments a fin de limitar la búsqueda únicamente a los segmentos cuyo 
estado es nuevo.  Resulta útil cuando se debe buscar y reemplazar de 
manera global solamente para la parte de la traducción que es nueva, 
obviando las coincidencias 100 %. 

Exclusión de segmentos ICE 
(coincidencias contextuales) en 
los resultados de la búsqueda 

En el panel Search Options, se puede tildar la casilla Exclude ICE 

Segments a fin de excluir de la búsqueda aquellos segmentos cuyo estado 
es ICE.  Resulta útil cuando se debe colocar el foco en segmentos que no 
son coincidencias contextuales exactas. 

Vista del contexto 

Al hacer clic derecho en un resultado de la búsqueda y elegir el elemento 
de menú See Context, aparecen las diez unidades que en el archivo se 
encuentran físicamente antes y después de la entrada actual. 
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Edición del documento de origen 

El elemento de menú Tools->Edit Source, también asociado a la 
combinación de teclas Ctrl+Alt+Intro o Ctrl+E, permite abrir el documento 
de origen al cual pertenece la entrada actualmente seleccionada.  Esto es 
muy útil si se quiere enmendar de manera rápida un error de terminología 
que se detectó durante una traducción en curso. Cuando el archivo fuente 
es un archivo *.itd de SDLX, un archivo *.ttx de Trados TagEditor, un 
archivo de Word para Trados o una carpeta de IBM Translation Manager, 
ApSIC Xbench abre directamente al segmento que contiene el texto.   

Para utilizar esta función con IBM Translation Manager, asegúrese de 
que IBM Translation Manager esté activo y de que no haya ningún 
documento en proceso de edición. 

Para los archivos delimitados por tabulaciones y las memorias de Trados 
exportadas, también está disponible el posicionamiento en la línea, 
aunque se deben configurar los parámetros del editor de texto desde 
Tools->Settings->Text Editor. Por ejemplo, para configurar el 
posicionamiento de línea en TextPad 4, se debe seleccionar allí el 
ejecutable de Text Pad y en Command-Line Parameters se debe 
especificar lo siguiente: $filename($line,$column). De manera similar, 
para configurar Notepad++, se debe elegir el ejecutable y en Command-

Line Parameters se debe especificar lo siguiente: $filename -n$line. 
Otros editores de texto habrán de admitir distintos valores para este 
campo. Remítase a la documentación del editor de texto a fin de obtener 
los valores adecuados. 

En el formato TMX, ApSIC Xbench permite también posicionarse en un 
segmento, aunque se debe configurar el editor de TMX desde Tools-
>Settings->TMX Editor. Por ejemplo, para configurar el 
posicionamiento en un segmento en OKAPI Olifant, se debe seleccionar 
allí el ejecutable de Olifant y en Command-Line Parameters se debe 
especificar lo siguiente: $Filename row=$Segment col=trg edit=yes. Otros 
editores de TMX pueden tener distintos valores para este campo. 
Remítase a la documentación del editor de TMX a fin de obtener los 
valores adecuados.  

Esto hace a ApSIC Xbench una herramienta muy útil y eficiente para 
efectuar cambios de terminología globales en estos formatos. Para una 
regresión posterior de los cambios, se puede recargar el proyecto de 
ApSIC Xbench con Project->Reload o View->Refresh. 
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Plantillas de búsqueda 

Las plantillas de búsqueda son búsquedas predefinidas que se pueden 
elegir y ejecutar. Para utilizar una plantilla de búsqueda, haga clic en 
Search Templates... del panel Search Options y, luego, elija la 
búsqueda de la lista. En Template Source, se puede elegir mostrar las 
entradas Sample Search Templates o Project Checklist.  Haga clic en 
Search para ejecutar de manera directa la búsqueda actualmente 
seleccionada o haga clic en Choose para llevar la definición de plantilla 
de búsqueda a los campos Source Term y Target Term. 
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Exportación de elementos 

ApSIC Xbench permite exportar los elementos de un proyecto en los 
siguientes formatos: 

� Archivos TMX 

� Archivos de texto delimitado por tabulaciones 

Para exportar el contenido de un proyecto, elija Tools->Export Items.  
Aparece el siguiente cuadro de diálogo: 

 

En este cuadro de diálogo, se pueden exportar todos los elementos de un 
proyecto, todos los elementos de una consulta actual, únicamente los 
elementos que muestra una consulta actual (por ejemplo, si se está en 
modo de descripción general, se ven únicamente algunos elementos de 
cada nivel de prioridad) o todos los elementos de un glosario que 
constituye el proyecto. 

En caso de desearlo, se pueden quitar las repeticiones (elementos que 
tengan exactamente los mismos valores fuente y meta) de los datos 
exportados a fin de reducir el tamaño del archivo resultante. También se 
pueden excluir de la búsqueda los segmentos ICE (coincidencias 
contextuales exactas). 

Adicionalmente, se pueden exportar únicamente los elementos sin 
traducir (por ejemplo, para facilitar el suministro en un sistema de 
traducción automática) o únicamente los elementos traducidos.  Si se 
elige exportar únicamente los elementos traducidos, se puede también 
especificar si se desea exportar únicamente los elementos pretraducidos 
(es decir, los elementos recuperados de una memoria de traducción) o los 
elementos traducidos recientemente. 
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Al exportar un archivo de texto delimitado por tabulaciones, se puede 
agregar una fila de encabezado.   

Al exportar un archivo TMX, se pueden especificar las variedades locales 
fuente y meta. Se puede especificar cualquier valor en estos campos. En 
caso de no recordar el código de variedad local, se puede presionar el 
botón de puntos suspensivos (...) para abrir una ventana de ayuda en la 
cual seleccionar el idioma y el país.   

 

Si por lo general se trabaja con un conjunto limitado de archivos, se 
puede hacer clic en el botón de flecha del cuadro combinado para abrir 
una lista de idiomas más acotada según las selecciones hechas 
recientemente. 
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Traducciones en curso 

ApSIC Xbench permite definir cualquier archivo como traducción en 
curso en la ventana Project Properties. 

Los siguientes tipos de archivo se definen como traducción en curso de 
manera predeterminada al ser agregados a un proyecto de 
ApSIC Xbench: 

� XLIFF 

� Trados TagEditor 

� Word para Trados 

� Trados Studio 

� SDLX. Nota: Para esta opción, se necesita tener SDLX instalado en el 
equipo.  

� STAR Transit 2.6/XV 

� PO 

� Carpetas de IBM TM 

� Carpetas de OpenTM2 

� TXML de Wordfast 

� Déjà Vu/Idiom 

� Logoport RTF 

Cuando se define un archivo o un directorio como traducción en curso, se 
habilitan las dos funciones siguientes: 

� Los segmentos que se identifican como nuevos (que no son 
coincidencias 100 %) se encuentran marcados con un pequeño punto 
de color rojo ( ). Los segmentos que son coincidencias 100 % en la 
traducción en curso están marcadas con un punto hueco de color rojo 
( ). Estos símbolos permiten distinguir si usted introdujo el término o 
si ya estaba incluido en la memoria existente.  Esto es de ayuda para 
tomar decisiones en cuanto a terminología, por ejemplo, si se desea 
actualizar la traducción respecto de un término y se quiere estar 
seguro de que el término no fue ya utilizado en la memoria oficial con 
la que se pretradujo el proyecto. 

� Los segmentos sin traducir aparecen después de los segmentos 
traducidos.  Esto es útil en especial para decidir cuál terminología 
utilizar para un término nuevo viendo de qué modo aparece en todas 
los casos futuros de la propia traducción.  De este modo, se puede 
asegurar que el término escogido se ajusta a todos los casos de la 
traducción actual. 

Nota: Los glosarios que se definen como traducción en curso (por lo 
general, solo uno por proyecto, pero puede haber más) aparecen con 
negritas en la ventana Project Properties. 
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Adicionalmente, los archivos definidos como traducción en curso se 
pueden analizar mediante las funciones avanzadas de QA de 
ApSIC Xbench. 
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Términos clave 

ApSIC Xbench permite definir uno o más archivos como Términos clave. 
Para ello, en la lista de glosarios de Project Properties, tilde la casilla 
Key Terms.  Como se ve en el ejemplo a continuación, aparece una 
estrella verde junto a la entrada del glosario, la cual indica que está 
marcado en la categoría Términos clave. 

 

Al definir un archivo como Términos clave, las entradas aparecen con 
una estrella, por encima de los resultados. El color de la estrella indica si 
el término clave es una coincidencia exacta (estrella verde ), una 
coincidencia exacta salvo por las mayúsculas y minúsculas (estrella 
amarilla ), o si el texto buscado forma parte de la entrada del término 
clave (estrella transparente ). 

En el ejemplo a continuación, se muestran las entradas “clipboard” y 
“Clipboard Viewer”, las cuales están marcadas como Términos clave: 
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En el ejemplo anterior, la estrella pintada de verde junto a la entrada 
“clipboard” indica que la entrada es una coincidencia total. La estrella 
transparente en la entrada “Clipboard viewer” indica que el término 
buscado forma parte de un término clave. 

La función de QA también hace uso de los términos clave definidos en el 
proyecto y comprueba si se han utilizado en la traducción en curso. 
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ApSIC Xbench ofrece funciones de control de calidad (QA) a fin de 
realizar comprobaciones avanzadas en los archivos definidos como 
traducción en curso.  Las funciones de QA buscan y encuentran los 
siguientes problemas potenciales: 

� segmentos sin traducir; 

� segmentos que tienen el mismo texto fuente pero distinto texto meta; 

� segmentos que tienen el mismo texto meta pero distinto texto fuente; 

� segmentos donde el texto meta es idéntico al texto fuente; 

� segmentos con inconsistencias de etiquetas; 

� segmentos con inconsistencias numéricas; 

� segmentos con dobles espacios; 

� segmentos que no respetan los términos clave del proyecto; 

� segmentos que satisfacen los criterios de búsqueda de elementos en 
listas de comprobación personales o de proyecto. Para obtener más 
información acerca de esta función, consulte Administración de listas 
de comprobación. 

  

Las funciones de control de calidad se efectúan con la pestaña QA en la 
ventana principal.  La pestaña QA sirve para las siguientes funciones: 

Realizar todas las comprobaciones seleccionadas en Check Group y en 
List of Checks haciendo clic en Check Ongoing Translation.  Todas las 
casillas se encuentran seleccionadas de manera predeterminada, a 
excepción de Target same as Source. 

� Realizar únicamente las búsquedas definidas por las Listas de 
comprobación de proyecto haciendo clic en Run Project Checklists. 

� Realizar únicamente las búsquedas definidas por las Listas de 
comprobación personales actuales haciendo clic en Run Personal 

Checklists. Para cambiar las Listas de comprobación personales 
actuales, elija Tools->Manage Checklists. 

� Exportar los resultados de QA que se muestran haciendo clic derecho 
y eligiendo Export QA Results en los siguientes formatos: HTML, 
texto delimitado por tabulaciones, Excel o XML. 

Funciones de control de calidad 
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Nota: Recuerde que la licencia de ApSIC Xbench no permite eliminar los 
créditos ubicados a la derecha del comienzo del informe de QA 
exportado.  Intentamos hacer que estos créditos no resulten una molestia; 
la finalidad de los mismos es evitar otras maneras más invasivas de 
promover el uso del producto entre pares.  

Los resultados se muestran en el cuerpo de la ventana de la pestaña QA. 
Con algunos formatos de archivo, se puede abrir el archivo directamente 

desde ApSIC Xbench en el segmento que se muestra a fin de corregirlo 
eligiendo Tools->Edit Source o presionando Ctrl+E. 

Se puede limitar el alcance de las cadenas contempladas por el proceso de 
QA tildando las casillas Only New Segments o Exclude ICE Segments.  

También se puede lograr que la modalidad de comprobación de 
consistencia distinga mayúsculas y minúsculas tildando la casilla Case-

sensitive Inconsistencies. 

Se puede ignorar el contenido de las etiquetas dentro de los segmentos al 
realizar el control de calidad si se selecciona Ignore Tags. Esto permite 
encontrar inconsistencias que tienen el mismo texto fuente o meta a 
excepción del interior de las etiquetas. 

Esta ventana permite marcar un problema haciendo clic derecho sobre el 
mismo y seleccionando Mark/Unmark Issue.  De manera opcional, se 
pueden mostrar o esconder los problemas marcados con los botones de 
radio Show Marked o Hide Marked en Filter Issues, a fin de limitar la 
cantidad de problemas que se visualizan. Nota: El comando Export QA 

Results exporta únicamente los problemas que se visualizan (y no 
exporta los problemas escondidos). 
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Administración de listas de 
comprobación 

Las listas de comprobación son una función de control de calidad (QA) muy 
útil de ApSIC Xbench. Al agregarse al motor de búsqueda de 
ApSIC Xbench, las listas de comprobación son una recopilación de 
búsquedas que se pueden ejecutar en lote para identificar segmentos con 
problemas. Típicamente, en las listas de comprobación se almacenan 
dificultades comunes, como el uso de expresiones o términos prohibidos. Es 
muy recomendable recopilar las devoluciones de los clientes en listas de 
comprobación a fin de asegurarse de no olvidarlas en traducciones sucesivas. 

Desde la pestaña QA de la ventana principal, se pueden ejecutar estas 
listas de comprobación en todos los archivos definidos como traducción 
en curso del proyecto de ApSIC Xbench. 

Dado que las listas de comprobación se agregan al motor de búsqueda de 
ApSIC Xbench, todo lo que se pueda buscar en ApSIC Xbench se puede 
agregar a una lista de comprobación. A decir verdad, una manera práctica 
de agregar una búsqueda a la lista de comprobación es llevarla a cabo 
primero desde la pestaña Project y, luego, hacer clic en Add Last 

Search to Checklist en el panel Search Options de la ventana principal. 

Existen dos tipos de listas de comprobación: las listas de comprobación 

de proyecto y las listas de comprobación personales. 

La lista de comprobación de proyecto se guarda con el archivo del 
proyecto de ApSIC Xbench (extensión *.xbp) y, por lo general, contiene 
comprobaciones que son específicas del proyecto, por ejemplo, palabras 
clave que no se traducen. 

Las listas de comprobación personales no se guardan en el archivo del 
proyecto de ApSIC Xbench, sino que se guardan en un archivo de lista de 
comprobación de ApSIC Xbench (extensión *.xbckl). ApSIC Xbench 
recuerda el último conjunto de listas de comprobación personales que se 
utilizaron a través de distintos proyectos.  Se puede tener una cantidad 
indefinida de listas de comprobación personales cargadas en un momento 
determinado. Por lo general, las listas de comprobación personales 
contienen comprobaciones que no son exclusivas de un proyecto, como 
errores comunes que no se detectan con el corrector ortográfico o reglas 
lingüísticas genéricas que conviene comprobar en varios proyectos.  Son 
“personales” porque los términos recopilados en estas listas suelen tener 
errores que un traductor determinado puede llegar a cometer. 

Las listas de comprobación se administran en el cuadro de diálogo 
Checklist Management. Se puede llegar al cuadro de diálogo Checklist 

Management mediante los siguientes métodos: 
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� eligiendo Tools->Manage Checklists; 

� haciendo clic en el icono Manage Checklists de la barra de 
herramientas. 

El cuadro de diálogo Checklist Management permite trabajar con las 
listas de comprobación personales y de proyecto. 

 
 
En el cuadro de diálogo Checklist Management, se pueden crear nuevas 
listas de comprobación personales eligiendo Checklist->New si el cursor 
está posicionado en el grupo Personal Checklists del árbol de navegación. 
También se puede agregar una lista de comprobación existente mediante 
Checklist->Add. Todas las listas de comprobación personales debajo de la 
lista Personal Checklists se ejecutan al hacer clic en Run Personal 

Checklists o Check Ongoing Translation en la pestaña QA. 

La lista de comprobación de «proyecto» se almacena en el archivo del 
proyecto de ApSIC Xbench (con extensión *.xbp), y no se puede quitar del 
grupo Project Checklists del árbol de navegación.  Se pueden agregar más 
listas de comprobación al grupo Project Checklists, que se ejecutan al hacer 
clic en Run Project Checklists o Check Ongoing Translation en la 
pestaña QA.  Los elementos de estas listas de comprobación de proyecto 
adicionales no se guardan en el archivo del proyecto de ApSIC Xbench en sí, 
pero se enlazan al proyecto, de modo que la próxima vez que se abre el 
archivo del proyecto de ApSIC Xbench, también aparece allí cualquier lista 
de comprobación enlazada. 

Los elementos de la lista de comprobación seleccionada en el árbol de 
navegación aparecen en el cuerpo de la ventana. Se pueden ordenar según 
cada columna.  Si se desea deshabilitar un elemento individual de una 
lista de comprobación, se puede destildar la casilla correspondiente.  
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Cabe destacar que, si se guarda la lista de comprobación, el elemento se 
guarda como destildado en el disco, de modo que la próxima vez que se 
abre la misma lista de comprobación el elemento permanece destildado. 

Al hacer clic en un encabezado de columna, se ordena de manera 
alfabética la lista de esa columna. Si se hace clic en el encabezado de 
columna por segunda vez, se ordena la lista de abajo hacia arriba. Si se 
escribe una secuencia de caracteres, se busca la secuencia de caracteres 
escrita en la columna actual. 

Se pueden agregar o editar elementos individuales de las listas de 
comprobación. Los campos disponibles son los mismos que se pueden 
especificar en el panel Search Options de la pestaña Project. 

 

Además, se puede también especificar una categoría para una entrada de 
la lista de comprobación en el cuadro combinado Category. Allí se puede 
especificar el nombre de cualquier categoría. Si se desea utilizar el 
nombre de una categoría previamente definida, se puede expandir el 
cuadro combinado haciendo clic en el botón de flecha y elegirlo de la 
lista. Si se han creado nombres de categorías, se pueden ejecutar de 
manera selectiva subconjuntos de categorías al ejecutar una lista de 
comprobación personal o de proyecto desde la pestaña QA utilizando los 
botones Run Project Checklists o Run Personal Checklists. 
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También se pueden definir relaciones de herencia entre las listas de 
comprobaciones. Cuando una lista de comprobación hereda de otra, se 
heredan todas las entradas. Se puede heredar de varias listas de 
comprobación. 

Para heredar una lista de comprobación, realice lo siguiente: 

1. Seleccione Edit->Inheritance->Add->Local (o haga clic en el botón 
Inheritance y, luego, haga clic derecho en la lista de elementos 
heredados que aparece y elija Add->Local). 

2. Escriba un nombre para la lista de comprobación heredada y elija el 
nombre del archivo que la contiene. El nombre aquí especificado no tiene 
que coincidir necesariamente con el nombre de visualización de la lista de 
comprobación. 

 

3. Siga los pasos 1 y 2 para agregar todas las listas de comprobación 
necesarias. El cuadro de diálogo muestra los elementos heredados 

mediante el icono . Se pueden cancelar estos elementos heredados 
pero no editarlos ni eliminarlos. 
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Una vez establecida una relación de herencia, se hereda cualquier cambio 
o adición que se lleve a cabo en la lista de comprobación primaria. 

La lista de comprobación de proyecto se guarda de manera automática al 
guardar el proyecto. Al agregar entradas a la lista de comprobación de 
proyecto y cerrar ApSIC Xbench, se le consulta si desea guardar el 
proyecto. 

Si se hace clic en Apply en este cuadro de diálogo, se guardan los 
cambios realizados en todas las listas de comprobación (a excepción de la 
lista de de comprobación de «proyecto» que se guarda con el archivo de 
proyecto.  Si se hace clic en OK, también se guardan los cambios y se 
cierra la ventana. 
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En esta sección, se desarrollan varios temas que ofrecen información 
adicional respecto de las funciones de ApSIC Xbench. 

 

Información adicional 
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Configuración de ApSIC 
Xbench 

En el menú Tools, haga clic en Settings para abrir el cuadro de diálogo 
Settings como se ve en el ejemplo a continuación. 

 

En este cuadro de diálogo, se puede configurar ApSIC Xbench a fin de 
iniciar siempre en modo maximizado (recomendado) y, además, cambiar 
los atajos de teclado predeterminados disponibles en todo el sistema. 
Nota: Cambiar los atajos de teclado predeterminados sería necesario solo 
como solución alternativa para evitar que entren en conflicto con otra 
aplicación que utilice las mismas teclas. 

Los campos en este diálogo son: 

Maximize on Startup. Al tildar esta casilla, ApSIC Xbench aparece 
maximizado cuando se inicia.  Se recomienda tildar esta casilla, dado que 
el modo maximizado es el que ofrece la máxima cantidad de información 
al mismo tiempo. 

Maximum Entries per Level in Overview Mode. El modo de 
descripción general muestra algunas entradas de cada nivel de prioridad. 
Especifique aquí la cantidad máxima de entradas por nivel.  Si después de 
la búsqueda se desea ver todas las coincidencias manteniendo los 
distintos niveles de prioridad, se puede presionar el vínculo azul Click 

here to show all matches que aparece debajo del panel de resultados del 
lado derecho, o tildar la casilla Show All Matches en el panel Search 

Options.  
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Las siguientes configuraciones pertenecen al grupo Hotkeys.  

Disable. Esta casilla permite deshabilitar las combinaciones de teclas 
válidas en todo el sistema que incluye ApSIC Xbench. Se recomienda 
dejar esta casilla destildada ya que una de las características más 
valiosas de ApSIC Xbench es la capacidad de buscar de manera 
directa desde cualquier aplicación. 

Source Hotkey. Este es el atajo de teclado asignado para 
desencadenar una búsqueda del contenido del portapapeles en el texto 
fuente (de manera predeterminada, Ctrl+Alt+Ins). 

Target Hotkey. Este es el atajo de teclado asignado para 
desencadenar una búsqueda inversa del contenido del portapapeles en 
el texto meta (de manera predeterminada, Ctrl+Alt+Retroceso). 

Automatic Substitution Hotkey. Este es el atajo de teclado asignado 
para reemplazar el texto meta de manera automática en el editor de 
traducción. Este atajo de teclado tiene la función de recoger 
traducciones de manera automática. Los requisitos para la sustitución 
automática son los siguientes:  

� debe haber una coincidencia exacta del término buscado; 

� debe haber una única variante del término buscado. 

Si no se cumple una de las dos condiciones previamente 
mencionadas, el comportamiento del atajo de teclado es el mismo que 
el de Source Hotkey. 

Se recomienda no cambiar la configuración de estos atajos de teclado 
a menos que entren en conflicto con los valores de otra aplicación. 

Internet Hotkeys / Open in default browser.  Cuando está tildada, 
abre en el explorador predeterminado la búsqueda de Internet 
asociada al atajo de teclado (por ejemplo, Ctrl+Alt+1 o Ctrl+Alt+2), 
en lugar de abrirla en el explorador integrado de ApSIC Xbench.  Por 
ejemplo, si se tiene la primera entrada configurada de vínculos 
definidos de Internet enlazada a Google, se puede utilizar esta función 
para buscar el texto marcado directamente en Google con solo 
presionar Ctrl+Alt+1. 

Transfer Method. ApSIC Xbench utiliza el portapapeles como 
mecanismo de transferencia entre las distintas aplicaciones de 
Windows y ApSIC Xbench. Por lo general, el método de 
transferencia más conveniente y consistente es dejar las opciones 
predeterminadas Manual Copy y Manual Paste, pero en algunas 
situaciones (por ejemplo, con aplicaciones que no incluyen la 
pulsación de teclas para copiar y pegar), es posible que se deban 
cambiar estas configuraciones para aprovechar ApSIC Xbench al 
máximo. 

Las opciones disponibles como método de transferencia para Input 
son: 
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Copy Message. Al presionar Ctrl+Alt+Ins, ApSIC Xbench envía un 
mensaje de COPIAR a la aplicación para copiar el texto seleccionado 
en el portapapeles y, luego, realiza una búsqueda utilizando el 
contenido del portapapeles. Una cantidad limitada de aplicaciones son 
compatibles con esta técnica, pero tiene la ventaja de evitar la 
necesidad de copiar de manera manual el texto en el portapapeles (por 
lo general, con Ctrl+Ins). 

Manual Copy. En este modo, ApSIC Xbench espera a que el usuario 
copie el texto por buscar en el portapapeles. Parece más tedioso, pero 
cuenta con la ventaja de que muchas aplicaciones son compatibles 
con la combinación de teclas Ctrl+Ins para copiar texto, lo cual se 
traduce en un comportamiento más consistente entre las aplicaciones. 
Como desventaja, si la aplicación de edición tiene un tiempo de 
respuesta muy lento, la combinación Ctrl+Ins o Ctrl+Alt+Ins puede 
resultar muy rápida para la aplicación. 

Keyboard Emulation (Ctrl+Ins). En este modo, ApSIC Xbench 
envía la pulsación de teclas Ctrl+Ins a la aplicación de edición y, 
luego, realiza la búsqueda. De esta manera, el usuario no tiene que 
presionar Ctrl+Ins de manera manual antes de la búsqueda. Es posible 
que algunas aplicaciones no sean compatibles con este método de 
entrada. 

Keyboard Emulation (Ctrl+C). En este modo, ApSIC Xbench envía 
la pulsación de teclas Ctrl+C a la aplicación de edición y, luego, 
realiza la búsqueda. De esta manera, el usuario no tiene que presionar 
Ctrl+C de manera manual antes de la búsqueda. Es posible que 
algunas aplicaciones no sean compatibles con este método de entrada. 

Las opciones disponibles como método de transferencia para Output y 
Automatic Substitution Output son: 

Paste Message. Al presionar Intro para seleccionar una traducción, 
ApSIC Xbench envía un mensaje de PEGAR a la aplicación para 
pegar la traducción. Una cantidad limitada de aplicaciones son 
compatibles con esta técnica, pero tiene la ventaja de evitar la 
necesidad de pegar de manera manual el texto en el portapapeles (por 
lo general, con Mayús+Ins). 

Manual Paste. En este modo, ApSIC Xbench copia el texto meta de 
la entrada seleccionada en el portapapeles si se presiona Intro para 
seleccionar una traducción. Se espera que el usuario presione 
Mayús+Ins (o la combinación de teclas correspondiente para pegar 
texto en la aplicación). Este es el modo predeterminado y 
recomendado por razones de consistencia entre las aplicaciones. 

Keyboard Emulation. En este modo, ApSIC Xbench envía el texto 
meta simulando que escribe el texto en la aplicación de edición 
cuando se selecciona una entrada y se presiona Intro para copiar la 
selección en el portapapeles. 

Keyboard Emulation (Ctrl+V). En este modo, ApSIC Xbench envía 
el texto meta simulando la pulsación de teclas Ctrl+V en la aplicación 
de edición cuando se selecciona una entrada y se presiona Intro para 
copiar la selección en el portapapeles. 
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Haga clic en la pestaña Colors de este cuadro de diálogo para cambiar los 
colores predeterminados de la ventana principal. Aparece la siguiente 
ventana: 

 

Las configuraciones de esta pestaña son las siguientes: 

� Background color when zoomed. Hay dos modos en 
ApSIC Xbench: descripción general, en el que se muestran algunas 
entradas de cada nivel de prioridad, y modo zoom, en el que se 
muestran todas las entradas de un nivel de prioridad. Este es el color 
de fondo que se utiliza en el modo zoom, como indicador de que no 
se está en modo de descripción general (el modo predeterminado es el 
de descripción general). 

� Key Terms priority. Este es el color que se utiliza para las entradas 
que pertenecen a la prioridad de Términos clave. En 
Project->Settings, se define un glosario como glosario de términos 
clave. 

� High Priority. Este es el color que se utiliza para las entradas que 
pertenecen a la prioridad elevada.  

� Medium Priority. Este es el color que se utiliza para las entradas que 
pertenecen a la prioridad intermedia. 

� Low Priority. Este es el color que se utiliza para las entradas que 
pertenecen a la prioridad reducida. 

� Background color when nothing found. Este es el color de fondo 
que aparece en el cuadro de búsqueda cuando no se encuentra una 
entrada. 
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Haga clic en la pestaña Internet para establecer las definiciones de 
Internet: 

 

La pestaña Internet permite definir los patrones de URL que se utilizan 
para efectuar búsquedas dirigidas en Internet, por ejemplo, en un 
diccionario.  Se pueden tener tantas entradas como se deseen, pero solo se 
asigna un atajo de teclado a las 10 primeras, ya sea Alt+n dentro de 
ApSIC Xbench o Ctrl+Alt+n (con el teclado numérico en este último 
caso en modo Bloq Num) desde cualquier aplicación de Windows. n 
puede ser un número del 0 al 9, donde 0 corresponde a la décima entrada 
de la lista. 

Se pueden utilizar los botones Up y Down para desplazar una entrada de 
la lista hacia arriba o hacia abajo. En el sitio web de ApSIC, se puede 
encontrar una biblioteca de URL listas para ser utilizadas. 

Las entradas (hasta 10 con una tecla asignada para cada una) aparecen en 
el menú Internet. 

Se puede utilizar Internet->Capture URL para agregar las URL en esta 
lista. 
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La pestaña Miscellaneous Settings permite especificar si se deben buscar 
actualizaciones de ApSIC Xbench de manera semanal y permite también 
habilitar la función de proyecto alternativo. 

 

Las configuraciones de esta pestaña son las siguientes: 

� Check weekly for new versions.  Si esta casilla se encuentra 
habilitada, ApSIC Xbench verifica una vez por semana si hay 
actualizaciones disponibles. 

� Enable alternative project. Si esta casilla se encuentra tildada, 
ApSIC Xbench mantiene en la memoria el proyecto abierto antes del 
actual.  Para activar uno u otro proyecto, elija Project->Switch to 

Alternative Project.  Para descartar el proyecto alternativo y 
recuperar la memoria que utiliza, elija Project->Forget Alternative 

Project. 

� Load last project when ApSIC Xbench starts. Si esta casilla se 
encuentra activada, la próxima vez que se inicia ApSIC Xbench, 
carga el proyecto que se encontraba abierto al momento del último 
cierre. 

� Show warning when copying fuzzy match. Si esta casilla se 
encuentra tildada, ApSIC Xbench emite un mensaje de advertencia si, 
al presionar Intro para copiar la entrada actualmente seleccionada en 
los resultados de la búsqueda, la entrada en cuestión no coincide de 
manera exacta con el término buscado. 

� Show warning when shutting down. Si esta casilla se encuentra 
tildada, ApSIC Xbench emite un mensaje de advertencia al cerrar el 
programa. 

� Default Project Directory. Este campo permite especificar la 
carpeta predeterminada para los proyectos de ApSIC Xbench. 
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La pestaña Text Editor permite configurar los argumentos de la línea de 
comandos para un editor de texto cuando se utiliza la función Edit 

Source para los resultados de la búsqueda o de QA en un glosario en 
formato *.txt. Esto abarca archivos delimitados por tabulaciones, 
memorias de Trados exportadas, memorias de Wordfast y glosarios 

de Wordfast.  Si se configura de manera adecuada, permite abrir el 
archivo directamente en la línea de donde proviene el segmento que se 
seleccionó mediante Edit Source.  

 

Si se elige definir un editor de texto, se deben asignar valores a los 
siguientes campos: 

� Path to Executable. Esta es la ruta al archivo *.exe para el editor de 
texto. Se puede utilizar el botón con puntos suspensivos (...) para 
navegar hasta el archivo *.exe. 

� Command-line Parameters. Estos campos permiten construir una 
línea de comandos que se debe pasar al editor. Se pueden utilizar 
varias variables que se reemplazan con valores de ApSIC Xbench: 

� $Filename: El nombre del archivo, incluyendo la ruta del archivo. 

� $Line: El número de línea del segmento en el archivo de texto. 
Esta línea hace referencia al lugar donde está ubicado el texto meta. 

� $Column: La columna en la línea donde está ubicado el texto meta. 

� $Segment: El número de segmento en el archivo de texto. 

Por ejemplo, para configurar el posicionamiento de línea en TextPad 4, 
se debe seleccionar allí el ejecutable de Text Pad y en Command-Line 

Parameters se debe especificar lo siguiente: $filename($line,$column). 
De manera similar, para configurar Notepad++, se debe elegir el 
ejecutable y en Command-Line Parameters se debe especificar lo 
siguiente: $filename -n$line. Otros editores de texto habrán de admitir 
distintos valores para este campo. Remítase a la documentación del 
editor de texto a fin de obtener los valores adecuados. 
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La pestaña TMX Editor permite configurar los argumentos de la línea de 
comandos para un editor de TMX cuando se utiliza la función Edit 

Source para los resultados de la búsqueda o de QA en un glosario en 
formato *.tmx. Si se configura de manera adecuada, permite abrir el 
archivo directamente en la línea de donde proviene el segmento que se 
seleccionó mediante Edit Source.  

 

Si se elige definir un editor de TMX, se deben asignar valores a los 
siguientes campos: 

� Path to Executable. Esta es la ruta al archivo *.exe para el editor de 
texto. Se puede utilizar el botón con puntos suspensivos (...) para 
navegar hasta el archivo *.exe. 

� Command-line Parameters. Estos campos permiten construir una 
línea de comandos que se debe pasar al editor. Se pueden utilizar 
varias variables que se reemplazan con valores de ApSIC Xbench: 

� $Filename: El nombre del archivo, incluyendo la ruta del 
archivo. 

� $Line: El número de línea del segmento en el archivo de texto. 
Esta línea hace referencia al lugar donde está ubicado el texto 
meta. 

� $Column: La columna en la línea donde está ubicado el texto 
meta. 

� $Segment: El número de segmento en el archivo de texto. 

Por ejemplo, para configurar el posicionamiento en un segmento en 
OKAPI Olifant, se debe seleccionar allí el ejecutable de Olifant y en 
Command-Line Parameters se debe especificar lo siguiente: 
$Filename row=$Segment col=trg edit=yes. Otros editores de TMX 
pueden tener distintos valores para este campo. Remítase a la 
documentación del editor de TMX a fin de obtener los valores 
adecuados. 
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Consejos prácticos para 
utilizar ApSIC Xbench 

Este capítulo está enfocado en las funciones más importantes de 
ApSIC Xbench y es un paneo rápido de lo que se puede hacer con 
ApSIC Xbench. 

Recomendamos enfáticamente leer este capítulo para obtener el máximo 
rendimiento de ApSIC Xbench con un mínimo esfuerzo de aprendizaje. 

� ApSIC Xbench no es un indizador,  sino que lee el contenido de los 
archivos cada vez que se carga un proyecto e intenta responder 
rápidamente a las consultas de terminología.  Por lo tanto, puede 
llevar varios minutos cargar todos los glosarios de Microsoft de un 
idioma principal y, además, se necesita una cantidad significativa de 
memoria. Si se planea cargar grandes cantidades de material de 
referencia (en el orden de las decenas de millones de palabras), se 
recomienda enfáticamente tener, por lo menos, 1 GB de memoria.  Si 
no se cuenta con una máquina muy potente, no se recomienda cargar 
todos los glosarios de Microsoft sino una selección más acotada de 
las áreas temáticas que resulten pertinentes al proyecto de traducción 
actual. 

� Una vez que se carga, ApSIC Xbench permanece activo en un 
segundo plano hasta que se cierra de manera explícita.  Cuando 
ApSIC Xbench se encuentra activo, aparece una gema rosa en la 
bandeja del sistema. Se debe cerrar ApSIC Xbench para descargarlo 
de la memoria.  Por ejemplo, se puede cerrar haciendo clic derecho en 
el icono que está en la bandeja del sistema y eligiendo Shutdown 

Xbench. 

� Mientras ApSIC Xbench se encuentre activo, puede ser llamado 
desde cualquier aplicación de Windows con la secuencia de teclas 
Ctrl+Alt+Ins. En caso de haber texto marcado en la aplicación, 
ApSIC Xbench lo busca de manera automática. Las pulsaciones de 
teclas se pueden configurar. 

� Además de glosarios de software de Microsoft, ApSIC Xbench es 
compatible con muchos formatos de entrada de varias aplicaciones 
CAT, incluyendo Trados, SDLX, Transit, Wordfast, IBM 
TranslationManager y otros formatos estándares de la industria como 
TMX, TBX o XLIFF. Se pueden combinar los distintos formatos en 
un proyecto de Xbench asignando prioridades a cada fuente para 
definir el proceso de decisiones terminológicas del proyecto de 
traducción específico. Se puede guardar cada proyecto de 
ApSIC Xbench para su reutilización posterior. 
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� Se puede presionar Intro en la ventana principal para copiar el texto 
meta del elemento actualmente seleccionado en el portapapeles.  La 
tecla Intro cierra la ventana y copia el texto de modo que se encuentre 
preparado para ser pegado en la aplicación en la que se edita la 
traducción con Mayús+Insert. Esto resulta muy útil al traducir la 
documentación de una aplicación de software cuyas cadenas de 
software están cargadas en un proyecto de ApSIC Xbench. 

� Se pueden ejecutar comprobaciones de QA con la pestaña QA. Las 
comprobaciones de QA se ejecutan únicamente respecto de glosarios 
definidos como traducción en curso. Una función muy avanzada de 
QA son las listas de comprobación, las cuales permiten ejecutar en 
lote una cantidad de comprobaciones predefinidas gracias a la potente 
capacidad de búsqueda de ApSIC Xbench. 

Después de adquirir cierta familiaridad con la capacidad básica del 
producto, se recomienda leer la documentación en detalle a fin de 
aprender muchas otras funciones incluidas en el producto. 
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Dónde obtener los glosarios 
de software de Microsoft y 
Apple 

Cómo obtener los glosarios de 
Microsoft 

A pesar de que los glosarios de software de Microsoft en formato *.csv 
solían estar a disposición del público desde el servidor FTP de Microsoft, 
al momento de esta publicación, únicamente se encontraban disponibles a 
través de una suscripción paga a MSDN. 

Cada idioma tiene un archivo *.zip separado que contiene todos los 
glosarios individuales para los productos de Microsoft localizados en ese 
idioma. El tamaño del archivo para cada idioma puede variar de 1 a más 
de 100 megabytes, lo cual depende de la cantidad de productos 
localizados por Microsoft en un idioma en particular. 

Cómo obtener los glosarios de 
Apple 

Al momento de esta publicación, los glosarios de software de Apple Mac 
OS X se encontraban disponibles en la siguiente fuente: 

� http://developer.apple.com/internationalization/downloads/ 

Los glosarios para cada idioma se encuentran en formato de imagen de 
disco para Macintosh (extensión *.dmg). Para cargar los glosarios de 
Mac OS en ApSIC Xbench, se deben extraer los archivos *.ad que 
contiene la imagen de disco. Para ello, se puede utilizar el software 
UltraISO : http://www.ezbsystems.com/ultraiso/index.html. 
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ApSIC Xbench permite definir vínculos de Internet que se pueden utilizar 
para buscar un término en Internet.  ApSIC Xbench incluye un 
explorador integrado simple, pero presionando Ctrl+W se puede abrir el 
explorador de Internet predeterminado del sistema en la página en la que 
se está navegando actualmente en ApSIC Xbench. 

 

Internet 
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Búsquedas en Internet 

ApSIC Xbench presenta una pestaña Internet que ofrece una ruta de 
integración con algunas fuentes de información y terminología 
disponibles en Internet. En el siguiente ejemplo, se muestra una búsqueda 
en Google efectuada desde ApSIC Xbench. 

 

ApSIC Xbench tiene algunos accesos directos predefinidos, pero el 
usuario puede cambiarlos o definir nuevos vínculos según sea necesario. 
Se puede acceder a los accesos directos definidos mediante alguno de los 
siguientes métodos: 

Vaya a la pestaña Internet, seleccione la fuente deseada en el campo 
Website, escriba la cadena de búsqueda en el campo Text to search y 
presione Intro. 

Con ApSIC Xbench como la aplicación activa, presione Alt+n, donde n 
puede ser cualquier número del 0 al 9. El 0 corresponde a la décima 
entrada de la lista. Para la búsqueda, se utiliza el término actual en el 
campo Source de la pestaña Project o en el campo Text to search de la 
pestaña Internet. El número corresponde al número de secuencia del 
acceso directo en Tools->Settings->Internet. 

Desde cualquier aplicación de Windows, resalte el término buscado y 
presione la combinación de teclas Ctrl+Ins seguida de Ctrl+Alt+n, donde el 
número n debe escribirse en el teclado numérico con Bloq Num activado. 
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Definición de accesos directos 
de Internet 

Los accesos directos de Internet se definen en Internet->Define Links. 
Los accesos directos son muy fáciles de definir. Solo siga estos pasos: 

1 Abra la lista de accesos directos en Internet->Define Links. Para 
crear una nueva entrada, hay que simplemente desplazar el cursor 
hacia abajo, más allá de la última entrada, con las teclas de dirección. 

 

2 Efectúe una búsqueda en la fuente del sitio web que desea comprobar.  
Por ejemplo, realice una búsqueda de un término en Google (por 
ejemplo, ‘xbench’). 

3 Copie la URL en el portapapeles; la URL puede, por ejemplo, verse 
como la siguiente: 

http://www.google.com/search?hl=en&lr=&ie=UTF-8&q=xbench 

4 Pegue la URL en una entrada de la ventana y reemplace el término 
que buscó con %s como se ve en el ejemplo. En búsquedas futuras 
que utilizan esta cadena de consulta, ApSIC Xbench reemplaza la 
secuencia %s con la cadena de búsqueda. 

5 Asigne un nombre al acceso directo moviendo el cursor a la columna 
Name y escriba el nombre allí. Este nombre aparece en el campo 
Website de la pestaña Internet y también en el menú desplegable 
Internet. 

6 Si se desea desplazar la entrada actual hacia abajo en la lista (lo cual 
tiene el efecto de cambiar el número de atajo de teclado), se puede 
hacer clic en los botones Up y Down ubicados en la parte inferior de 
la ventana. 
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Si al explorar un página utilizando la pestaña Internet de ApSIC Xbench 
se encuentra un vínculo interesante, se puede agregar rápidamente a la 
lista de páginas con el elemento de menú Internet->Capture URL. 

Si se tiene la barra de herramientas activada, aparecen varios botones que 
ayudan a navegar por las páginas de Internet. Uno de estos botones 
permite abrir Internet Explorer en la misma página que se está viendo. 
Esto también se puede hacer con el menú Internet ->Open Browser o 
con el atajo de teclado Ctrl+W. 
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Errores y sugerencias 
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Informe de errores y 
sugerencias 

Sus comentarios respecto de errores en el programa son más que 
bienvenidos. También estamos abiertos a sugerencias en cuanto a cómo 
mejorar ciertas áreas que puedan parecer confusas.  

Envíe un informe de errores o sus sugerencias a 
http://www.apsic.com/en/products_submit_bug.aspx 

Cualquier información que envíe será confidencial y se utilizará 
únicamente a los efectos de resolver el problema. 
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